THERMAL TESTING ON THE LENOVO
THINKPAD T420, DELL LATITUDE E6420,
AND HP ELITEBOOK 8460P

Cool

The Lenovo ThinkPad
T420 laptop kept its cool
during our thermal tests

Using laptops in the workplace offers workers benefits, including greater
mobility and flexibility, but also presents a major drawback: the heat that many laptops
give off can frustrate workers, especially when they are on the go. Picking up a hot
laptop numerous times a day becomes uncomfortable and annoying. Additionally,
hotter operating temperatures are more likely to cause various hardware failures,
increasing the expense and inconvenience of laptop repair or replacement and of lost
work.

To combat these problems, Lenovo designed the Lenovo ThinkPad T420 with
lower operating temperatures in mind.

Principled Technologies used a thermal imaging camera and a data logger to
record the surface temperature of the Lenovo ThinkPad T420 and two other laptops in
spots that affect user comfort: the palm rest, the touchpad, the fan outlet, and the
underside of the laptop at its hottest spot. We measured the temperatures in these
areas while various workloads ran, and found that the Lenovo ThinkPad T420 provided a
more comfortable user experience than the Dell™ Latitude™ E6420 and HP EliteBook
8460p, by remaining as much as 10.8 degrees Celsius cooler. Because many workers use
their laptops constantly throughout the day, and in different locations, the consistently
lower temperatures of the Lenovo ThinkPad T420 improve its ability to be a comfortable
and reliable laptop for users.
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THE IMPORTANCE OF KEEPING COOL

Many employees have their laptops with them for the majority of their
workday—at their workstation, in meetings, at other remote locations, and at home
when necessary. For this reason, the match of employee to laptop must be a successful
one. When making the purchase decision for your department, remember to factor in
basic comfort as a purchase point. The surface temperature of an active laptop plays a
significant factor in user comfort—users definitely notice when their laptop is running
uncomfortably hot.

The productivity of the entire organization suffers when an employee laptop
malfunctions. A user might lose his or her work, have to wait for a replacement system,
or waste time attempting to troubleshoot the problem. Furthermore, no company
wishes to spend additional money replacing broken laptops. It is common knowledge
within the IT industry that operating temperatures degrade hardware reliability. Excess
heat can cause hard drives, CPUs, memory, and other components to fail. For example,
overheating can expand hard drive platters, causing a hard drive to fail. At the very
least, excess heat will likely reduce the drive’s effective operating life. According to a
recent Fujitsu whitepaper, hard disk manufacturers now suggest cooler operating
temperatures for the drive enclosures.” Because many users fail to back up their data on
a regular basis, adequate ventilation and cooling in a laptop plays a large part in
avoiding problems, such as catastrophic data loss due to hard drive failure.

With user comfort and system reliability in mind, we measured the temperature
of key spots on the three identically configured laptops, all of which feature the same
2nd generation Intel® Core™ processor, while they ran different workloads. For more
information about how we tested, see Appendix D.

We measured the temperature of the laptops at key spots that affect user
comfort, and found that the Lenovo ThinkPad T420 generally ran cooler. Figure 1 shows
the range of temperatures (above ambient temperature) we recorded at the laptops’
key spots, while running each of the six workloads. Because the ambient temperature
varied throughout our testing, the temperature difference between the ambient
temperature and the surface temperature we recorded for each system makes the
fairest comparison.

! http://www.fujitsu.com/downloads/COMP/fcpa/hdd/sata-mobile-ext-duty_wp.pdf
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Figure 1: Range in temperatures above ambient temperature, in degrees Celsius, at key spots on the laptops for the six
workloads. Lower numbers are better.

WHAT WE FOUND

In our tests, we found that the Lenovo ThinkPad T420 was generally cooler in
the key spots we measured while running different workloads. Figure 2 on the next page
shows the temperature difference, in degrees Celsius, between the ambient
temperature and the surface temperature we recorded for each system, and presents
the coolest temperatures in light blue. This measurement provides the best comparison
for the user experience the laptops provided. See Appendix C for the absolute
temperature readings we recorded.
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Laptop | Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

DivX® Encode with XMPEG MPEG-4 encoding

Ambient temperature 22.8°C 23.2°C 22.2°C
Right palm rest AT=3.3 AT=4.6 AT=6.3
Touch pad AT=6.8 AT=7.0 AT=6.8
Fan outlet AT=5.1 AT=12.5 AT=8.7
Ep”odters'de hottest AT=8.4 AT=10.2 AT=8.6
Futuremark® PCMark ®Vantage

Ambient temperature 23.6°C 23.5°C 21.9°C
Right palm rest AT=2.7 AT=3.7 AT=6.3
Touch pad AT=6.4 AT=7.1 AT=6.9
Fan outlet AT=8.1 AT=18.4 AT=12.4
Underside hottest AT=10.1 AT=10.9 AT=10.0
spot

MAXON CINEBENCH 11.5

Ambient temperature 23.1°C 23.1°C 22.8°C
Right palm rest AT=2.8 AT=4.6 AT=6.3
Touch pad AT=6.3 AT=7.3 AT=6.8
Fan outlet AT=6.7 AT=16.4 AT=10.7
gp”odters \de hottest AT=9.6 AT=11.9 AT=9.3
Monte Carlo Excel® recalculation

Ambient temperature 23.7° 23.6° 21.5°
Right palm rest AT=3.3 AT=5.7 AT=5.7
Touch pad AT=6.7 AT=8.2 AT=6.8
Fan outlet AT=3.8 AT=11.0 AT=6.6
Underside hottest AT=7.2 AT=11.5 AT=7.5
spot

POV-Ray CPU

Ambient temperature 24.5° 24.3° 23.6°
Right palm rest AT=3.0 AT=4.9 AT=6.6
Touch pad AT=6.5 AT=7.8 AT=7.0
Fan outlet AT=8.5 AT=19.3 AT=13.2
Underside hottest AT=10.7 AT=11.7 AT=10.4
spot

Windows Media® Encoder 9

Ambient temperature 23.7° 23.7° 22.3°
Right palm rest AT=2.5 AT=5.2 AT=6.5
Touch pad AT=6.1 AT=8.1 AT=7.1
Fan outlet AT=3.5 AT=10.0 AT=6.4
Underside hottest AT=6.1 AT=11.9 AT=8.8
spot

Figure 2: Degrees Celsius above ambient temperature of key spots for the laptops while running each workload.
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Figures 3 through 8 show the thermal images of the laptops, while running the
six workloads, with temperatures in degrees Celsius above ambient temperature at key
spots on the laptops.

As Figure 3 shows, during the DivX Encode with XMPEG MPEG-4 encoding
workload, the key spots on the Lenovo ThinkPad T420 ranged from 3.3°C to 8.4°C above
ambient temperature, the Dell Latitude E6420 ranged from 4.6°C to 12.5°C above
ambient temperature, and the HP EliteBook 8460p ranged from 6.3°C to 8.7°C above
ambient temperature.

DivX Encode with XMPEG MPEG-4 encoding

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 22.8°C Ambient temperature = 23.2°C Ambient temperature = 22.2°C

Figure 3: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the DivX Encode with XMPEG MPEG-4 encoding workload.
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As Figure 4 shows, during the Futuremark PCMark Vantage workload, the key
spots on the Lenovo ThinkPad T420 ranged from 2.7°C to 10.1°C above ambient
temperature, the Dell Latitude E6420 ranged from 3.7°C to 18.4°C above ambient
temperature, and the HP EliteBook 8460p ranged from 6.3°C to 12.4°C above ambient
temperature.

Futuremark PCMark Vantage

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 23.6°C Ambient temperature = 23.5°C Ambient temperature = 21.9°C

Figure 4: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the Futuremark PCMark Vantage workload.
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As Figure 5 shows, during the MAXON CINEBENCH 11.5 workload, the key spots
on the Lenovo ThinkPad T420 ranged from 2.8°C to 9.6°C above ambient temperature,
the Dell Latitude E6420 ranged from 4.6°C to 16.4°C above ambient temperature, and
the HP EliteBook 8460p ranged from 6.3°C to 10.7°C above ambient temperature.

MAXON CINEBENCH 11.5

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 23.1°C Ambient temperature = 23.1°C Ambient temperature = 22.8°C

Figure 5: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the MAXON CINEBENCH 11.5 workload.
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As Figure 6 shows, during the Monte Carlo Excel recalculation workload, the key
spots on the Lenovo ThinkPad T420 ranged from 3.3°C to 7.2°C above ambient
temperature, the Dell Latitude E6420 ranged from 5.7°C to 11.5°C above ambient
temperature, and the HP EliteBook 8460p ranged from 5.7°C to 7.5°C above ambient
temperature.

Monte Carlo Excel recalculation

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 23.7°C Ambient temperature = 23.6°C Ambient temperature = 21.5°C

Figure 6: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the Monte Carlo Excel recalculation workload.
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As Figure 7 shows, during the POV-Ray CPU workload, the key spots on the
Lenovo ThinkPad T420 ranged from 3.0°C to 10.7°C above ambient temperature, the
Dell Latitude E6420 ranged from 4.9°C to 19.3°C above ambient temperature, and the
HP EliteBook 8460p ranged from 6.6°C to 13.2°C above ambient temperature.

POV-Ray CPU

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 24.5°C Ambient temperature = 24.3°C Ambient temperature = 23.6°C

Figure 7: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the POV-Ray CPU workload.

Thermal testing on the Lenovo ThinkPad T420, Dell Latitude E6420, A Principled Technologies test report 9
and HP EliteBook 8460p




As Figure 8 shows, during the Windows Media Encoder 9 workload, the key
spots on the Lenovo ThinkPad T420 ranged from 2.5°C to 6.1°C above ambient
temperature, the Dell Latitude E6420 ranged from 5.2°C to 11.9°C above ambient
temperature, and the HP EliteBook 8460p ranged from 6.4°C to 8.8°C above ambient
temperature.

Windows Media Encoder 9

Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Ambient temperature = 23.7°C Ambient temperature = 23.7°C Ambient temperature = 22.3°C

Figure 8: Thermal images, with temperatures, in degrees Celsius above ambient temperature, at key spots for the laptops running
the Windows Media Encoder 9 workload.
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SUMMARY

As they bring their work from the office to the boardroom to their homes,
workers need no longer suffer from the discomfort and reliability problems from laptops
that run consistently hot. As we demonstrated in our tests, the Lenovo ThinkPad T420
stays cooler overall than the Dell Latitude E6420 and HP EliteBook 8460p in spots that
are key for a pleasant user experience. This makes the Lenovo ThinkPad T420 a great
choice for users looking for a laptop with the power of 2™ generation Intel Core
processors and the ability to stay cool while handling their most difficult work.

Thermal testing on the Lenovo ThinkPad T420, Dell Latitude E6420, A Principled Technologies test report 11

and HP EliteBook 8460p



APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 9 provides detailed configuration information about the test systems. Note that PT purchased these

systems directly from their respective vendor, and that all systems remained in their factory default setting for our tests.

System Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p
General

Number of processor packages 1 1 1

Number of cores per processor 2 2 2

Number of hardware threads per ) ) )

core

System power management
policy

Max performance

Ultra performance

High performance

Processor power-saving option

Enhanced Intel
SpeedStep® Technology

Enhanced Intel SpeedStep
Technology

Enhanced Intel SpeedStep
Technology

System dimensions (length x

13-3/8” x9-1/4” x 1-3/8”

13-7/8” x 9-1/2” x 1-1/4”

13-3/8” x 9-1/4” x 1-3/8”

width x height)
System weight 4 lbs. 13 oz. 5 Ibs. 5 oz. 5 Ibs. 6 oz.
CPU
Vendor Intel Intel Intel
Name Core i7 Core i7 Corei7
Model number 2620M 2620M 2620M
Stepping D2 D2 D2
Socket type and number of pins Socket 988B rPGA Socket 988B rPGA Socket 988B rPGA
Core frequency (GHz) 2.70 2.70 2.70
Bus frequency 5.0 GT/s DMI Link Speed 5.0 GT/s DMI Link Speed 5.0 GT/s DMI Link Speed
L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 512 KB (256 KB per core) 512 KB (256 KB per core) 512 KB (256 KB per core)
L3 cache 4 MB (shared) 4 MB (shared) 4 MB (shared)
Platform
Vendor Lenovo Dell HP
Motherboard model number 4177CTO OKODNP 161C
Motherboard chipset Intel Q167 Intel Q67 Intel Q67

. Lenovo 83ET46WW (1.16 HP 68SCF Ver. F.01
BIOS name and version (03/07/2011) ( ) Dell AO1 (03/02/2011) (03/11/2011)
Memory module(s)

Samsung Hyundai Samsung

Vendor and model number M471B5273CHO-CH9 HMT35156BFR8C-H9 M471B5273DH0-CH9
Type PC3-10600 PC3-10600 PC3-10600
Speed (MHz) 1,333 1,333 1,333
Speed running in the system 1333 1333 1333
(MHz)
Tlmlng/Latency (tCL-tRCD-tRP- 9-9-9-24 9-9-9-24 6-6-6-20
tRASmin)
Size (MB) 4,096 4,096 4,096
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System Lenovo ThinkPad T420 Dell Latitude E6420 HP EliteBook 8460p

Number of memory module(s) 1 1 1

Amount of RAM in system (GB) 4 4 4

;Zfdc/);iaunkllz::c;?dnegs)lngle- Double-sided Double-sided Double-sided

Channel (single/dual) Single Single Single

Hard disk

Vendor and model number Hitachi Western Digital Hitachi
HTS723232A7A364 WD3200BEKT-75PVMTO HTS725032A9A364

Number of disks in system 1 1 1

Size (GB) 320 320 320

Buffer size (MB) 16 16 16

RPM 7,200 7,200 7,200

Type SATA 3.0Gb/s SATA 3.0 Gb/s SATA 3.0 Gb/s
Intel Mobile Express Intel Mobile Express Intel Mobile Express

Controller Chipset SATA AHCI Chipset SATA RAID Chipset SATA AHCI
Controller Controller Controller

Driver Intel 10.1.0.1008 Intel 10.1.0.1008 Intel 10.1.2.1004
(11/06/2010) (11/06/2010) (01/12/2011)

Operating system

Windows® 7 Professional

Windows 7 Professional

Windows 7 Professional

Name x64 x64 x64

Build number 7600 7600 7600

Service Pack NA NA NA

File system NTFS NTFS NTFS

Kernel X64-based PC X64-based PC X64-based PC
Language English English English

Microsoft DirectX® version 11 11 11

Graphics

Vendor and model number Intel HD Graphics 3000 Intel HD Graphics 3000 Intel HD Graphics 3000
Type Integrated Integrated Integrated

Chipset Intel HD Graphics Family Intel HD Graphics Family Intel HD Graphics Family
BIOS version 2089.0 2089.11 2089.0

Total available graphics memory

(MB) 1,696 1,696 1,696

Dedicated video memory (MB) 64 64 64

System video memory (MB) 0 0 0

Shared system memory (MB) 1,632 1,632 1,632

Resolution 1,366 x 768 1,366 x 768 1,366 x 768

Driver Intel 8.15.10.2321 Intel 8.15.10.2266 Intel 8.15.10.2291
(03/06/2011) (12/16/2010) (01/27/2011)

Sound card/subsystem
Conexant 20672 IDT High Definition Audio | IDT High Definition Audio

Vendor and model number

SmartAudio HD

CODEC

CODEC
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System

Lenovo ThinkPad T420

Dell Latitude E6420

HP EliteBook 8460p

Conexant 8.32.14.0

IDT 6.10.0.6316

IDT 6.10.6325.0

Driver (11/22/2010) (12/07/2010) (01/27/2011)

Ethernet

Vendor and model number Intel 82579LM Gigabit Intel 82579LM Gigabit Intel 82579LM Gigabit

Driver Intel 11.8.84.0 Intel 11.8.81.0 Intel 11.8.84.0
(12/21/2010) (10/28/2010) (12/21/2010)

Wireless

Vendor and model number

Intel Centrino Advanced-N
6205

Intel Centrino Advanced-N
6205

Intel Centrino Advanced-
N 6205

Driver Intel 14.0.1.2 Intel 14.0.1.2 Intel 14.0.1.2
(12/21/2010) (12/21/2010) (12/21/2010)

Optical drive(s)

Vendor and model number Matshita UJSAOA TSSTcorp TS-U633) HP TS-L333F

Type DVD-RW DVD-RW DVD-RW

USB ports

Number 3 4 4

Type USB 2.0 USB 2.0 USB 2.0

Other eSATA & media card eSATA & media card eSATA & media card

reader

reader

reader

IEEE 1394 ports

Number 1 |0 1

Monitor

LCD type LED LED LED

Screen size 14.0” 14.0” 14.0”

Refresh rate (Hz) 60 60 60

Battery

Type Lenovo 42T4795 Lithium- | 1, | 1.4 Lithium-ion HP CCO6 Lithium-ion

on

Size (length x width x height)

8-3/16” x 2-1/8” x 13/16”

8-1/4" x 2" x7/8”

8-1/8" x 1-15/16" x
13/16”

Rated capacity

10.8V / 5,200mAh / 57Wh

11.1V / 5,400mAh / 60Wh

11.1V / 5,600mAh / 62Wh

Weight

12 oz.

11 oz.

11 oz.

Figure 9: Configuration information for the test systems.
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APPENDIX B — SCHEMATIC OF THE LAPTOP FOR TEMPERATURE
READINGS

Figure 10 shows where we measured temperature on the topside of each laptop. Please note that for the HP
EliteBook 8460p, the fan outlet area is on the opposite side of the laptop shown here.

Touchpad Palm rest

Figure 10: Yellow text indicates the areas where we measured temperature.
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Figure 11 shows the underside of a laptop, where we measured the hottest spot, as determined by our thermal
imager.

Hot spot

Figure 11: Underside of a laptop. We used a thermal imager to determine the hottest point and measured temperature at that
spot.
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APPENDIX C — DETAILED TEST RESULTS

Figure 12 shows the laptop temperatures at key spots, in degrees Celsius, while running each workload.

Laptop | Lenovo ThinkPad T420 | Dell Latitude E6420 HP EliteBook 8460p
DivX Encode with XMPEG MPEG-4 encoding

Ambient temperature 22.8°C 23.2°C 22.2°C
Right palm rest 26.1 27.8 28.5
Touch pad 29.6 30.2 29.0
Fan outlet 27.9 35.7 30.9
Underside hottest spot 31.2 334 30.8
Futuremark PCMark Vantage

Ambient temperature 23.6°C 23.5°C 21.9°C
Right palm rest 26.3 27.2 28.2
Touch pad 30.0 30.6 28.8
Fan outlet 31.7 41.9 34.3
Underside hottest spot 33.7 34.4 31.9
MAXON CINEBENCH 11.5

Ambient temperature 23.1°C 23.1°C 22.8°C
Right palm rest 25.9 27.7 29.1
Touch pad 29.4 30.4 29.6
Fan outlet 29.8 39.5 335
Underside hottest spot 32.7 35.0 32.1
Monte Carlo Excel recalculation

Ambient temperature 23.7° 23.6° 21.5°
Right palm rest 27.0 29.3 27.2
Touch pad 30.4 31.8 28.3
Fan outlet 27.5 34.6 28.1
Underside hottest spot 30.9 35.1 29.0
POV-Ray CPU

Ambient temperature 24.5° 24.3° 23.6°
Right palm rest 27.5 29.2 30.2
Touch pad 31.0 32.1 30.6
Fan outlet 33.0 43.6 36.8
Underside hottest spot 35.2 36.0 34.0
Windows Media Encoder 9

Ambient temperature 23.7° 23.7° 22.3°
Right palm rest 26.2 28.9 28.8
Touch pad 29.8 31.8 29.4
Fan outlet 27.2 33.7 28.7
Underside hottest spot 29.8 35.6 31.1

Figure 12: Temperature, in degrees Celsius, of key spots for the laptops while running each workload.

Thermal testing on the Lenovo ThinkPad T420, Dell Latitude E6420, A Principled Technologies test report 17
and HP EliteBook 8460p




APPENDIX D — HOW WE TESTED

This appendix outlines the series of tests we used to measure surface heat in key spots that affect the user’s
comfort while working on the system. To measure the thermal profile of the laptop systems as they run various
performance benchmarks requires two specialized tools: a FLIR® i7 thermal imaging camera and a Fluke® NetDAQ®
2680A Data Acquisition System with Type T thermocouples, which includes both a hardware device and software that
runs on a controller PC.

A thermocouple is a junction between two different metals that produces a voltage related to a temperature
difference. We used Type T thermocouples, which are suited for measurements in the -200° to 350°C range.

Data acquisition (DAQ) is the process of sampling signals that measure real-world physical conditions, in this
case, temperature. For our testing, we installed the Fluke DAQ software on a controller PC connected via Ethernet to the
NetDAQ device. Five Type T thermocouples connect to the NetDAQ through a 20-channel input module, and attach to
five test points on the laptop PC under test. We placed thermocouples in the fan outlet area and underside hot spot by
using the Fluke FLIR i7 imaging camera to determine the hottest point in each location. The location of the hard disk test
point depends upon the manufacturer’s placement of the hard disk. Each of these five channels is configured and
controlled using the Fluke DAQ software installed on the controller PC. As each benchmark runs, the NetDAQ logs, in
real time, the temperature of each of the five test points. After each run, the NetDAQ log is exported to Excel. We
reviewed the output to determine the highest temperature and its associated performance score. In this way, we
learned how much the surface temperature rises above ambient temperature when the laptop PC runs performance
benchmarks.

In addition to logging the surface temperature in real time with the NetDAQ, we captured a thermal image using
a Fluke FLIR i7 thermal imaging camera. These images provide a digital record of the thermal map of both the top and
the underside of the laptop for each benchmark test.

The FLIR i7 is fully automatic. Similar to any digital camera, you simply point and click to see the heat variations
in heat of the environment or surface of interest. The camera creates a visual representation of heat differences.

All of the tests require a Fluke 2680A Data Acquisition System to measure surface temperature on the laptop
and to ensure a consistent ambient temperature between 70°F and 74°F. Appendix B presents a schematic that shows
the key spots on each laptop where we measured the temperature.

Setting up the laptop

1. Set the power plan to high performance using the Power Options control panel.
2. Set the display brightness to 100 percent:
a.  Click Start.
b. Inthe Start menu’s quick search field, type Power Options.
c.  Move the Screen brightness slider all the way to the right.
3. Set the remaining power plan settings as follows:
. Dim the display: Never
. Turn off the display: Never
. Put the computer to sleep: Never
Disable the screen saver.
Plug the AC adapter into the laptop, and completely charge the battery.
Place the laptop in a windowless, climate-controlled room.
Attach a type-t thermocouple to the laptop in the four locations noted in Appendix B.
Configure the Fluke NetDAQ 2680A Data Acquisition System to take measurements from the four surface

PN R

Thermal testing on the Lenovo ThinkPad T420, Dell Latitude E6420, A Principled Technologies test report 18
and HP EliteBook 8460p



temperature probes and one ambient temperature probe using the Fluke DAQ software.

a. Connect the five type-t thermocouples to five channels in the Fluke Fast Analog Input module (FAl).

b. Inthe Fluke DAQ software, click each surface temperature channel, select Thermocouple from the list of
Functions, and choose T from the list of ranges.

c. Label each channel with the surface location associated with each thermocouple.

d. Inthe Fluke DAQ software, click the ambient temperature channel, select Thermocouple from the list of
Functions, and choose T from the list of ranges.

e. Label this channel Ambient.

9. While running each test, use a Fluke 2680A Data Acquisition System to monitor ambient and surface temperature.

Measuring surface temperature of the laptop while running the DivX Encode with XMPEG
MPEG-4 encoding workload

Test requirements

. Fluke 2680A Data Acquisition System
° FLIR i7 thermal camera

Setting up the test

Reset the system with the appropriate test image.
Download XMPEG 5.0.3 from http://www.videohelp.com/tools/XMPEG.
Download DivX 8 from http://www.divx.com/en/software/download/start.
Install XMPEG 5.03 and DivX 8 with the default options.
Copy the hdwatermellon.mpg file to My Videos.
Right-click the XMPEG 5.0 window, select Open, select the hdwatermellon.mpg file, and click Open.
Right-click the XMPEG 5.0 window again, and select options: Uncheck boxes for auto under the Format and FPS
sections; make sure the YV12 format is selected, and click OK.
8. Right-click the XMPEG 5.0 window again, and choose Set Plug-in options.
9. Select the Codec compression radio button.
10. Select the DivX 6.x Codec and click Configure 1st pass.
o Set the Certification Profile to “1080HD”and click OK.
o Click Configure 1st pass, again, set the Rate control mode to 1-pass at 8000 kbit/s, and click OK.
o Click Configure 1st pass, again, slide the Encoding presets slider as far to the right as possible, and click OK.
(Ensure this is set the same for all laptops)
11. Click the Audio tab, select No Compression, and click OK.
12. Exit XMPEG.

Running the test

NouswnNE

Reboot the system.
Launch XMPEG, right-click the XMPEG 5.0 window and select Open.
Select the hdwatermellon.mpg and click Open.
Start the Fluke 2680A data logger using the Fluke DAQ software.
Right-click the XMPEG 5.0 window, choose Start Conversion.
Stop the Fluke 2680A data logger using the Fluke DAQ software when the conversion completes.
Save the thermal measurement data to a CSV file.
Repeat steps 2 through 8 two more times, and report the median of the three runs.
Use the thermal measurement CSV file to find and report the highest temperature measured at each location during
the test.
. Use the time stamp of the highest temperature to determine when to take the thermal image during the third run of
the benchmark. Take images of both the top and bottom of the laptop using a FLIR i7 thermal imaging camera.
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Measuring surface temperature of the laptop while running Futuremark PCMark Vantage

Test requirements

. Fluke 2680A Data Acquisition System
° FLIR i7 thermal camera

Setting up the test

1. Reset the system with the appropriate test image.

2. Download the PCMark_Vantage_v100_installer.exe Windows package from
www.futuremark.com/benchmarks/pcmarkvantage/download/.

3. Install PCMark Vantage 1.0.0 with the default options by double-clicking the PCMark_Vantage_v100_installer.exe
file.

4. Launch PCMark Vantage 1.0.0 by clicking on the PCMark Vantage x64 desktop icon. Enter the registration code, click
Register, and click OK.

5. Exit PCMark Vantage 1.0.0.

6. Download the PCMark Vantage 1.0.2.0 Patch (PCMark_Vantage v102_ patch_1901.exe Windows package) from
www.futuremark.com/benchmarks/pcmarkvantage/download/.

7. Install the patch by double-clicking the PCMark_Vantage v102_patch_1901.exe file.

Running the test

Reboot the system.
Double-click the PCMark Vantage desktop icon to launch the benchmark.
Verify all test suites are selected, and that the HDD Suite target is set to C..
Start the Fluke 2680A data logger using the Fluke DAQ software.
Accept the default settings in PCMark Vantage, and click Run Benchmark.
When the benchmark run completes, click Submit results.
Stop the Fluke 2680A data logger using the Fluke DAQ software.
Save the thermal measurement data to a CSV file from the NetDAQ software.
Use the thermal measurement CSV file to find and report the highest temperature measured at each location during
the test.
. Use the time stamp of the highest temperature during the first run to determine when to take the thermal image of
the laptop during the third run of the benchmark. Take images of both the top and bottom of the laptop using a FLIR
i7 thermal imaging camera.

WoNOURWNRE

=
o

Measuring surface temperature of the laptop while running MAXON CINEBENCH 11.5
Test requirements

. Fluke 2680A Data Acquisition System
. FLIR i7 thermal camera

Setting up the test

1. Reset the system with the appropriate test image.
2. Download CINEBENCH 11.5 from http://www.maxon.net/downloads/cinebench/cinebench-115/disclaimer.html.
3. Double-click CINEBENCH ZIP file to extract CINEBENCH R11.5.

Running the test

1. Reboot the system.

2. Launch CINEBENCH R11.5 by double-clicking the CINEBENCH file in the CINEBENCH_11.529 folder.
3. From the menu, select File=>Advanced benchmark.

4. From the list of tests in the left panel, select CPU and CPU (Single Core).
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Start the Fluke 2680A data logger using the Fluke DAQ software.

From the menu, select File>Run all selected tests.

Stop the Fluke 2680A data logger using the Fluke DAQ software.

Save the thermal measurement data to a CSV file from the NetDAQ software.
Close CINEBENCH.

. When asked if you would like to save your benchmark score, click No.
. Repeat steps 2 through 10 two more times.
. Use the thermal measurement CSV file to find and report the highest temperature measured at each location during

the test.

. Use the time stamp of the highest temperature during the first run to determine when to take the thermal image of

the laptop during the third run of the benchmark. Take images of both the top and bottom of the laptop using a FLIR
i7 thermal imaging camera.

Measuring surface temperature of the laptop while running the Monte Carlo Excel
recalculation workload

Test requirements

. Fluke 2680A Data Acquisition System
. FLIR i7 thermal camera

. Microsoft Excel 2010

. Monte Carlo Black Sholes test file

Setting up the test

Lo N~ WNRE

Reset the system with the appropriate test image.

Copy the MonteCarloBlackScholesOptionPricing.xIsm test file to the Documents directory.

Locate the MonteCarloBlackScholesOptionPricing.xlsm workload file, and double-click the file to open it.
Click Excel Options.

In the left column, click Trust Center.

Click Trust Center Settings.

In the left column, click Macro Settings, and select Enable all macros.

Click OK.

Close Excel.

Running the test
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Reboot the laptop.

Start the Fluke 2680A data logger using the Fluke DAQ software.

Locate the MonteCarloBlackScholesOptionPricing.xIsm workload file, and double-click the file to open it.

Press Ctrl+R to begin the Excel recalculation.

When the Excel recalculation completes, a dialog reports the execution time of the scenario.

Stop the Fluke 2680A data logger using the Fluke DAQ software.

Save the thermal measurement data to a CSV file from the NetDAQ software.

Repeat steps 2 through 7 two more times without rebooting between runs.

Use the thermal measurement CSV file to find and report the highest temperature measured at each location during
the test.

. Use the time stamp of the highest temperature during the first run to determine when to take the thermal image of

the laptop during the third run of the benchmark. Take images of both the top and bottom of the laptop using a FLIR
i7 thermal imaging camera.
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Measuring surface temperature of the laptop while running POV-Ray CPU
Test requirements

. Fluke 2680A Data Acquisition System

° FLIR i7 thermal camera
Setting up the test

1. Reset the system with the appropriate test image.

2. Download the latest version of POV-Ray for Windows (currently version 3.7 RC3) from
http://www.povray.org/download/.

3. Install POV-Ray with the default options by double-clicking the.msi you just downloaded.

Running the test

1. Reboot the system.

From the Start menu, launch POV-Ray.

Start the Fluke 2680A data logger using the Fluke DAQ software.

Select the Messages tab, and select Run Benchmark (All CPU’s) from the Render menu option.

When the benchmark run completes, stop the Fluke 2680A data logger using the Fluke DAQ software.

Save the thermal measurement data to a CSV file from the NetDAQ software.

Repeat steps 2 through 6 two more times.

Use the thermal measurement CSV file to find and report the highest temperature measured at each location

during the test.

9. Use the time stamp of the highest temperature during the first run to determine when to take the thermal
image of the laptop during the third run of the benchmark. Take images of both the top and bottom of the
laptop using a FLIR i7 thermal imaging camera.
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Measuring surface temperature of the laptop while running the Windows Media Encoder 9
workload
Test requirements
. Fluke 2680A Data Acquisition System
. FLIR i7 thermal camera
Setting up the test

1. Reset the system to the base test image.

2. Download and install Microsoft Windows Media Player 10 with default settings from
http://www.microsoft.com/windows/windowsmedia/mp10/default.aspx.

3. Download and install Windows Media Encoder 9 with default settings from
http://www.microsoft.com/windows/windowsmedia/9series/encoder/default.aspx.

4. Copy the kitesurfing.avi to the My Videos directory.

Running the test

Reboot the system.

Launch Windows Media Encoder 9 by clicking Start—=>Programs—=>Windows Media—=>Windows Media Encoder.
Highlight Custom Session, and click OK.

Under the Sources tab, click the File radio button from the choices for Source from.

Click the Browse button, and navigate to the kitesurfing.avi file in the My Videos directory.

Click Open.

Click the Output tab.

Uncheck Pull from encoder in the center of the screen.
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10.
11.
12.
13.
14.
15.
16.
17.
18.

19.
20.
21.
22.
23.
24,
25.
26.

27.

Check Encode to file towards the bottom of the screen.

Type Output in the File name box.

Click the Compression tab.

Click Edit...

In the Media Types section, select Windows Media Video 9 Advanced Profile next to Video.

Click OK.

Click Apply. A dialog will appear stating that the output file has been renamed with a new extension.

Click OK.

Start the Fluke 2680A data logger using the Fluke DAQ software.

Click the small green Start Encoding button at the top of the screen. The green progress bar at the bottom-right of
the screen shows the status of the encoding process.

When an Encoding Results window appears, stop the Fluke 2680A data logger using the Fluke DAQ software.

Save the thermal measurement data to a CSV file from the NetDAQ software.

Click Close.

Close Windows Media Encoder. A window appears asking to save the session.

Click No.

Using Windows Explorer, find and delete the output.wmv file.

Repeat steps 2 through 24 two more times.

Use the thermal measurement CSV file to find and report the highest temperature measured at each location during
the test.

Use the time stamp of the highest temperature during the first run to determine when to take the thermal image of
the laptop during the third run of the benchmark. Take images of both the top and bottom of the laptop using a FLIR
i7 thermal imaging camera.
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APPENDIX E - OUR TEST BENCHMARKS

This section provides a brief explanation of each of the benchmark applications we used to test each laptop.

DivX Encode with XMPEG MPEG-4 encoding

XMPEG open-source conversion software allows users to encode video files to DivX format. We used it to
convert an AVI file to DivX format. XMPEG can be downloaded from numerous sites, including
http://download.cnet.com/XMPEG/3000-2194 4-10698769.html.

Futuremark PCMark Vantage

Futuremark’s PCMark Vantage v1.0.2.0 benchmark suite tests system CPU and GPU performance, RAM speeds,
and hard drive read/write speeds. The benchmark runs common tasks such as video playback, audio and video
transcoding, data encryption, Windows mail, game testing, and Web page rendering. For more information on this
benchmark, see http://www.futuremark.com/benchmarks/pcmarkvantage/introduction/.

MAXON CINEBENCH 11.5

CINEBENCH is a free, real-world cross platform test suite designed to evaluate and compare the CPU and
graphics performance across various systems and platforms. Based on MAXON CINEMA 4D software, which creates 3D
content, the benchmark consists of two main components: the graphics-card performance test, and the CPU

performance test. CINEBENCH uses the processing power of a system to render 3D scenes that stress all available
processor cores, and reports performance in points (pts). Higher scores are better, as they indicate a faster processor.
To learn more, visit http://www.maxon.net.

Monte Carlo Excel recalculation

The Monte Carlo spreadsheet is a mathematical simulation that runs in Microsoft Office Excel. 300,000 instances
of the Monte Carlo-Black Sholes mathematical simulation ran in Excel, where they calculated hypothetical call and put
prices, and used Excel’s lookup functions to compare these prices against historical market prices.

POV-Ray CPU

The Persistence of Vision Raytracer (POV-Ray) is a 3D-graphics creation tool that provides a good benchmark for
CPU usage. We used the 3.7 RC3 release. For more information about POV-Ray, visit http://www.povray.org/.

Windows Media Encoder 9

Microsoft Windows Media Encoder 9 is a tool that allows you to convert or capture both live and prerecorded

audio, video, and computer screen images to Windows Media formats. For more information about Windows Media
Encoder 9, visit http://windows.microsoft.com/en-US/windows/products/windows-media.
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